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Colligo Contributor Client

Introduction

Welcome to Colligo Contributor Client, the program helps extend the power of SharePoint to mobile and
remote workers. Instantly and securely access, modify, and create SharePoint documents, list items, and
metadata while offline. Sync changes to libraries and lists automatically when connected. Keep team
members productive, regardless of network latency or unavailability, in the field or on the road.

Benefits

Colligo Contributor Client helps:

e Empower users to easily manage email and documents in SharePoint

e Increase the quantity of content captured and tagged in SharePoint

e Make SharePoint accessible directly from the desktop

e Drive mobile and remote workforce productivity with easy offline access
e Improve collaboration, and document project management

e Improve records retention to reduce risk and improve compliance

Features

Colligo Contributor Client lets you:

e Drag-and-drop documents to SharePoint

e Navigate to cached SharePoint content

e Sync documents, document sets, libraries, or entire SharePoint sites

e Open, save, organize, and classify SharePoint files directly from Windows Explorer

Platforms Supported

e  Microsoft SharePoint Server 2010, MOSS 2007, SharePoint Portal Server (SPS) 2003
e SharePoint Foundation Microsoft Windows SharePoint Services (WSS) 3.0, or 2.0

e SharePoint 2010 Online (Office365)

e SharePoint 2013 Preview

e QOutlook 2007, 2010, 2013 Preview (32-bit and 64-bit)

e Windows XP Professional, Windows Vista, Windows 7, Windows 8
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Installing and Activating Contributor Client

To install and activate Contributor Client:
1. Double-click to open the zip file and extract the contents.

Colligo Contributor Client

2. Inthe folder, double-click the folder that corresponds to your operating system:

a) x64: choose this option if you have a 64-bit operating system
b) x86: choose this option if you have a 32-bit operating system
3. Double-click either Setup.exe or .msi.
4. Follow the steps in the install wizard.
5. After the install is complete, the following dialog displays:

it

Activate Colligo Contributer

Welcome to Colligo Contributor!

To start using this software, please activate it while connected to the
Internet. Providing your email address will ensure you periodically
receive product notices, version releases, and our newsletter. Your
personal privacy is important to us - your information will never be
shared with a third party.

Click here to view our Privacy Statement.

RegistrationInformation

MName: |

Organization: |

Email: |

Activate | Exit ‘

6. Enter yourinformation and click Activate. If you do not activate Contributor Client, it will not launch.
7. After you have installed Contributor Client, choose Colligo Contributor from your Start menu or

from the system tray icon to launch the interface:

i@l Colligo Contributor Client

File Site View Help

- z Synchronize... - 0}1 View Sync [ssues

Site: [ <Mo Sites>

Mew ~ | Upload ~ | Filter =

Sync Issues

Issue Item Site List

'@) Mo Synchronization Activity

2l

The Document Libraries and Lists display in the left column, and the content of the selected list or

library displays in the right section.

12/10/2012

Copyright 2012 Colligo Networks, Inc. All rights reserved.

Page 3 of 18

Not to be reproduced without permission. Learn more at www.colligo.com.



Colligo Contributor Client

Activating Contributor Client Manually

If you are unable to connect to the activation server, the following error message displays:

-
Activate Collige Contributor l&,l

Activation Failed

The Colligo Activation Server was not reachable, Activation
will be attempted the next time you use the software.
Alternately, you can choose to activate through email,

Activate via Emai | Activate Later |

Click Activate via Email to create an activation request file. The following dialog displays:

Activate Collige Contributor Li_E-J

To activate Colligo Contributor File Manager via email, dick
"Export Activation Request™, An activation request file will be
generated, which you can then email to Colligo Technical Support
where your activation request will be fulfiled.

Email Colligo Support: support@colligo.com

| Export Activation Request | Exit |

L S

Click Export Activation Request. This creates a .txt file that you can save anywhere on your machine,
and then attach to an email that you can send to Colligo to request a manual activation.

Checking for Updates

In the Contributor Client Control Panel, you can check if you are using the most current version of the
program:
1. From the Help menu, select Check for Update. The www.colligo.com site launches.

2. |If there is a newer version available, click the Download the latest version now link to install the
newer build.

Updating Your License Key

In the Contributor Client Control Panel, you can change your license key:

1. From the Help menu, select Install License Key.

2. The Enter License Key dialog displays. Enter your new license key and click OK.
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~
Enter License Key

)

Please enter your 25-digit license key (indude dashes):

Cancel

12/10/2012
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Connecting SharePoint Sites

Colligo Contributor Client

You can add a SharePoint list or library to Contributor Client in one of two ways:

e Using the Connect to Contributor option in Internet Explorer

e Using the Download New Site option

Using the Connect to Contributor Button

1. Navigate to a SharePoint List or Library in Internet Explorer.
2. Click the green Connect to Contributor icon on the toolbar.

http://vs-sp2010/PM/Shared%20Docume 2 ~ & X

File Edit View Favorites Tools Help

Shared Documents - All Do...

i v B v [ dm v Pagev Safetyv Tooksv @+ @i N @ (v 53 @

Library Tools

Site Actions ~ @l TSNS Documents Library

Connect to Contributor

3. The Download New Site dialog displays. Select either your default Windows credentials, or supply

other user-specific credentials.
o Download New Site @

Site: | <New Site> |

URL: D 5P

Examples:  http:/fserver fworkspace
https: /fsecureserver fworkspace

Server Authentication
(¥ Use default credentials
" Use the following credentials:

User name: |

Password: |

Download | Close

o A

4. Click Download.
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The Select for Synchronization dialog displays the lists and libraries you have permissions for:

[=—3=]]

p
Select for Synchronization

—Document Libraries and Lists
" Synchronize all document libraries and lists
& Synchronize the following:

E Announcements

[ calendar

[=] Links

3| Private Documents

[Tl Product Lifecycle Dashboard
[1] release Dashboard

i3] Shared Documents

23| Site Assets

3] Site Pages

[ [E]Tasks

[ I R e |

Click the chedkbox to enable or disable synchronization for
the spedfied list.

Checkal |  Unchedcal | Fiter... |

Synchronize I

Close |

“ o

Check the boxes beside the lists and libraries you want to synchronize
All buttons if needed.

Click Filter to select which folders and views you want to synchronize.
The Select Filters for Synchronization dialog displays:

; use the Check All or Uncheck

. B
Select Filters for Synchronization u
£~ Disable Synchronization for this Document Library
' Synchronize Entire Document Library
& Only synchronize content based on the following filters:
—Synchronized Folders
Available Folders Selected Folders
By
[C3 Arakelyan et al v. Contoso LLC
| [Z ICE Co vs Contoso
&dd == |
Remaove |
—Synchronized Views
Selected Views I
[T All Documents
[T My Matters Add == |
j Recent Documents
Remaove |
| |
Cancel Filker Refresh CK Cancel
. |
12/10/2012 Copyright 2012 Colligo Networks, Inc. All rights reserved.
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7. Choose from the following options:

e Disable Synchronization for this Document Library: choose this option if you do not want
the document library to be available offline.

e Synchronize Entire Document Library: choose this option if want to synchronize everything
in the specified document library.

e Only synchronize content based on the following filters: choose this option if you want to
selectively choose what folders and views are synchronized. In the Synchronized Folders
and Synchronized Views sections, select a folder or view you want to synchronize and click
Add to move it to the Selected Folders/Views column.

8. Click OK.
9. Click Synchronize to download the information for the lists and libraries you have selected.

12/10/2012 Copyright 2012 Colligo Networks, Inc. All rights reserved. Page 8 of 18
Not to be reproduced without permission. Learn more at www.colligo.com.



Using the Download New Site Option

To connect a site from within Colligo Contributor Client:

1. From the Site menu, choose Download New Site:

Colligo Contributor Client

=
(@) Colligo Contributor Client

File Site Wiew Help

Site: ;-_, Synchronize...

o Q_ﬂ Wiew Sync Issues

2l oad - | Filter -
]

Download New Site... |

Manage Sites...

Sync Issues

Issue Item

Site

List

3

@ Mo Synchronization Activity

ke

The Download New Site dialog displays:

-
s Download New Site

URL:
Examples: htip://serverworkspace
https://secureserver /workspace

Server Authentication
(@) Use default credentials
) Use the following credentials:

User name:

Password:

Cancel

Download

-

-

2.

12/10/2012
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3. See steps 6 to 9 of Using the Connect to Contributor Button.
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Editing Lists and Libraries

After you have added your site and chosen which lists and libraries you want to sync, you may want to
go back at a later time and edit your choices. You can do this in one of two ways:

1.

OR

1.

2.

owu kW

Colligo Contributor Client

Right-click a list or library and select Enable Synchronization from the contextual menu. Then
synchronize the site.

From the Site menu, choose Download New Site.

The Download New Site dialog displays:

-

5 Download New Site l&]

URL: Colligo Intranet
Product Management
IIL'ED""'%E'I'H:I TROTFSpace

Site: | <New Site> -

Exampres:
htips: /fsecureserver jworkspace

Server Authentication
* |se default credentials
" Use the following credentials:

User name: |

Password: |

| Close |

From the Site drop-down list, choose which site you want to configure.

The Synchronize Site dialog displays:

-

= Synchronize Site léj

Ell:=Ha | Colligo Intranet '

URL: |htt|:|:ﬂv5—sp2010

Examples: http:/fserver jworkspace
https://secureserver jworkspace

Synchronization Settings

@ Only some lists will synchronize.
3 complete, 0 partial, 9 disabled

Configure...

[ perform full synchronization

Selecting this option synchronizes all site content, including users, views
and templates. If your permissions on the site have changed, you
should select thiz option to get all the content you now have access to.
Selecting this option will result in longer download times.

Synchronize | Close |

Click Configure.
In the Configure Synchronization dialog, choose which Lists and Libraries you want to sync.
Click OK.

Synchronize the new site.

12/10/2012
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Setting Synchronization Options
In Contributor Client you can set your Synchronization options to your lists and libraries sync

automatically. However, you can also perform manually syncs as well.

Configuring Synchronization Settings

1. From the View menu, select Options.
The Colligo Contributor Options dialog displays:

Colligo Contributor Options Liz-,l

l

Storage

Storage location
|C: \Wserstmackinnon\AppDataiLocal\ColligoO:

General
Iv Prompt for properties when adding documents

™ Use current Windows® appearance

Synchronization

Iv synchronize on startup

¥ synchronize when list is viewed

¥ Synchronize when list is modified

¥ Enable background synchronization

Background synchronization interval: IB‘D— minutes

Iv Automatically download lists to resclve Site Column values

Ok ‘ Cancel ‘ |

“ A

2. Inthe General section, you can turn on the prompt to record properties about the document by
checking the Prompt for properties when adding documents box. You can override this setting for
specific lists/libraries when you are configuring Default Metadata; see Setting Default Metadata.

3. Inthe Synchronization section, choose your preferred options:

a. Synchronize on startup: choose this option if you want your lists and libraries to synchronize
every time Contributor Client starts

b. Synchronize when list is viewed: choose this option if you want your lists and libraries to
synchronize every time you view a list or library

c. Synchronize when list is modified: choose this option if you want your lists and libraries to
synchronize every time you modify a list or library

d. Enable background synchronization: choose this option if you want to set the
synchronization to happen in the background on a time-specific basis, and enter your
preferred time interval

e. Automatically download lists to resolve Site Column values: if you have lists that reference
other lists (look-ups), checking this option ensures the related referenced lists are also
downloaded

NOTE: Depending on how your IT Administrator has configured the installation, this dialog may not be
accessible to you, or the synchronization options may be greyed out.
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Synchronizing Sites Manually

After you have added your sites, you may want to synchronize them manually, outside of the settings
you set in the Colligo Contributor Options dialog:

1. Click the Synchronize menu to display the options:

l@ Colligo Contributor Client

[F=3 Eol &
File Site View Help
Site: [, JBDemo - zsinﬁronize... - %\n‘ieu\' Sync Issues
. g Synchronize "JBDemo” Site. ..
ﬁ -:|_J -"_-'.5'] Synchronize Multiple Sites...
Documents i) synchronize Al Fa view: | AllDocuments - || ]
= JB Matters g Synchronize Pending Changes r Modified
4 Download New Site. .. 12/14/2011 2:18 PM
[ 1 Hiltan v Marriott 10/26/2011 12:20 PM
Lists

3 Jones v Morgan 12/14/2011 2:18 PM

[Cd Pepsi v Coke 10/26/2011 12:21 PM
[ Smith v Brown 12/14/2011 2:17PM
- Colligo Events_19Apr10 13.01.59_last chance to ... 12/15/2011 10:25 AM

_l Colligo Metworks_21Apr10 14.21.17_Reminder Yo... 12152011 10:25 AM
2= Qutlook 2003 Team_0&Apri0 14.04.26_Welcome t... 12/15/2011 10:25 AM

< | i

'@'} Last Synchronization: 2/28/2012 11:55:36 AM

Choose from the following:

e Synchronize Site: select this option to synchronize the site currently displayed

Synchronize Multiple Sites: select this option to display all sites and choose which ones you
want to synchronize

e Synchronize All: select this option to synchronize all sites

Synchronize Pending Changes: select this option to synchronize any lists or libraries containing
changed content

The Synchronization In Progress dialog displays for any of the above options:

Synchronization In Progress... [é]
Site List: Site: 4 Colligo Intranet
% |4 Coligo Intranet Server: ':@ http:ffvs-sp2010
4 Contoso LLC Synchronization Activity
& Matter Repository Current List: A Customized Reports
s Product Management Status: Collecting remote updates ...
Received: 0of0 Sent: 0of 0
Working ...
Skip Site | Cancel All
[ Close this window when synchronization completes

Completing a Full Synchronization

Several of the synchronization dialogs have a Perform Full Synchronization option. This option means
that additional information is downloaded, including definitions for Sites, Lists, Views, and Content
Types, plus other site content that may not be retrieved during other standard sync processes.

12/10/2012 Copyright 2012 Colligo Networks, Inc. All rights reserved.

Page 12 of 18
Not to be reproduced without permission. Learn more at www.colligo.com.



Viewing and Synchronizing Pending Changes

Colligo Contributor Client

You can review content that has changed since the last synchronization and then synchronize it:

1. From the View menu, select View Pending Changes.
The Pending Synchronization Changes dialog displays:

Pending Synchronization Changes
Name
ESite: B's Beverages (5)

o]

775\(& 1l List 7M0dlﬁed ﬂStatus -

8] 8's Project.docx
B2 peleteDomains. xis
'} Engagement Management.ppt

B 171 Case Study - short_bwj.doc
4] Meta Tags Report.docx

§ifi 8's Beverages
3 8's Beverages
%' B's Beverages
3 B's Beverages
§iB's Beverages

(3]Project Emails and ... 26/02/2008 2:20:59PM  Update
[3|Project Emails and ... 26/02/2008 2:20:59PM  Ujpdate
JE51 Project Emails and ... peiomicacemoniconit i piare

3] Project Emails and . Discard Changes s

[3|Project Emails and ... 26/02/2008 2:20:59PM  Ujpdate

2. To discard the changes for a particular item, right-click it and choose Discard Changes. Discarded
changes are reverted upon the next synchronization.

3. Click Synchronize.

12/10/2012
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Creating New Content

After you have added your sites and synchronized your lists and libraries, the content is cached
(available offline). You can now open and edit SharePoint items, check items in and out of SharePoint, as
well as rename and delete items.

In addition to editing existing content in SharePoint, you can also add new content to your synchronized
lists and libraries.

You can add items to Contributor Client in one of the following ways:
o Create new documents from within the Contributor Client interface
e Upload existing content
e Drag-and-drop or copy-and-paste content

Adding a New Document to a List/Library
To add a new document to a list or library:

1. With the list or library you want to add the document to selected, click the New menu and select
your preferred document type from the drop-down list:

'.:{! Colligo Contributer Client EI@
Ele Site View Help
Site: 1y JBDemo - :Sinmronize... - 01 View Sync Issues
- JEDemo > JB Matters
\
| =l JB Matters
Documents Mew = || Upload - | Filter = View:  All Documents ~ || [[T]]
D LBl @ Email Modified
@] Document 12/14/2011 2:18 PM
|d—l 10/26/2011 12:20 PM
=
Lists g e 12/14/2011 2:18 PM
[ Pepsi v Coke 10/26/2011 12;21PM
[ Smith v Brown 12142011 2:17 PM

- Colligo Events_194pr10 13.01.59_Last chance to ... 12/15/2011 10:25 AM
_l Colligo Networks_21Apri0 14,21, 17 Reminder Yo... 12/15/2011 10:25 AM
== Qutook 2003 Team_05Apr10 14.04.25_Welcome t... 12/15/2011 10:25 AM

1 | i

l@) Last Synchronization: 2/28/2012 11:55:36 AM
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5.

The Create New Document dialog displays:

-
_] Create New Document @
Site Templates | Qther

@J

template

Please enter a name for this new document:

Mew Document

[ Create ] [ Cancel ]

L5

Colligo Contributor Client

Choose your document type from the Site Templates tab or the Other tab.

Enter a name for the document, and click Create.

The New Item dialog displays. This is where you can record information about the document that is
stored in SharePoint as well as choose the location of the document (click Folder to browse the

folders and subfolders in the list or library).

Edit the New Item dialog as preferred.

Document

fiw j Mew Document. docx
Falder

B

Properties

Content Type: |Docurnent j

MName =

Mew Document. docx

Title

template. dotx

People or Groups

|(uone) =l

Managed Metadata

! |

Create | Cancel |

_a| JB Matters: New Item @

Vi

Click Create. The document is added to the SharePoint location.
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Using the Upload Documents Dialog

To add an existing document to a list or library:
1. With the list or library you want to add the document to selected, click the Upload menu, and
choose Upload Documents:

'.;i! Collige Contributor Client EI@
File Site Wiew Help
Site: |, JBDemo - gsinchronize. v \%_ View Sync Issues
- JEDemo = JB Matters
|’
e JB Matters
Documents Mew - |[Upload = || Filter = View: | All Documents ~ | ]
" JB Matters Name | ¥ Upload Documents " Modified
[ Hewitt v Anderson 12/14/2011 2:18 PM
[ Hilton v Marriott 10262011 12:20 FM
Lists [ Jones v Morgan 12/14/2011 2:18 PM
|1 Pepsi v Coke 10/26/2011 12:21 FM
[ Smith v Brown 12142011 2:17 PM

=] Colligo Events_19#pr10 13.01,59_Last chance to ... 12/15/2011 10:25 AM
-1 Colligo Networks_21Apr10 14.21.17_Reminder Yo... 12/15/2011 10:25 AM
-] Qutlook 2003 Team_06Apr10 14.04,26_Welcome t... 12/15/2011 10:25 AM

« | 2l

'.;ﬁl Last Synchronization: 2282012 11:55:36 AM

The Upload Documents dialog displays.

2. Browse to the document that you want to upload, and click Open. To select more than one
document, use Ctrl + click.

3. The New Item dialog displays. Edit as preferred and click Create.
The document is added to the SharePoint location. If you have selected more than one document,
any properties you assign apply to all items.

Dragging-and-Dropping Content

You can drag-and-drop one or more files or complete folder structures into Contributor Client from your
desktop or from other directory locations.

1. Drag-and-drop your preferred files or folders from your desktop or another directory to your
preferred SharePoint location in Contributor Client.

2. The New Item dialog displays. Edit as preferred and click Create. The file or folder is added to the
SharePoint location. If you have selected more than one document or a folder, any properties you
assign apply to all items.
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Setting Default Metadata

If you want to tag all documents and items that you add or upload to a list or library with the same
metadata, you can set default metadata values through the Contributor Client interface:

1. From the Control Panel File menu, choose Default Metadata Values.
The Default Metadata Values dialog displays:

Default Metadata Values &J

|contoso LLE |

Mame Value Inherited From Apply To

111 Content and Structure Reports
23| Customized Reparts
)
3] Drop Off Library
|3 Form Templates
|3 Images

111 Reusable Content
23] Site Collection Documents
23] Site Collection Images
23] Style Library

] Workflow Tasks

Add... When adding documents, prompt for properties:
" Always
[ Inherit propagating values from parentitems ™ Mever
[~ Clear locally-defined values on all child items {* According to application global settings

0K | Cancel Apply

2. Select the site and library/list that you want to configure.

3. To add a metadata tag, click Add.
The Add Default Meta data Properties dialog displays, displaying the metadata field options that
are set in the document library in SharePoint.

Add Default Metadata Properties &J

Title

™|

Scheduling Start Date
|

Scheduling End Date
™ |

'7 Fropagate Mese ETault METadatsa values 1o
aithfnldara

4. Enter your preferred tags and click Add.

5. If you want the values to propagate to any subfolders, check the Propagate these default metadata
values to subfolders box.

6. To configure the behavior or the prompt to record document properties, choose a radio button on
the right under the When adding documents, prompt for properties section:

e Always
e Never
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e According to application global settings (as set in step 2 in Configuring Synchronization
Settings)
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